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ABSTRACT 
The chassis frame is a crucial component of a vehicle, as it bears the weight of the vehicle and provides a secure foundation for its various parts. Its main purpose is to safely carry the maximum load for all operating conditions for which it is designed. In a vehicle, the chassis serves as the backbone, onto which parts such as the gearbox and engine are mounted. Traditionally, twowheeler chassis have been made of steel, which is dense and heavy. However, in our project, we are exploring the use of alternative materials such as aluminium alloys, titanium, and carbon fiber, which are lighter in weight and provide high strength. This would result in a lighter chassis without compromising on strength. Our project focuses on the design of a two-wheeler chassis frame and its weight optimization. To achieve this, we carried out static loading tests on the chassis and improved its mechanical behaviour by using alternative materials. We used CATIA V5 for modeling and ANSYS software for analysis, specifically through finite element analysis (FEA). Our modeling process considered the geometry characteristics of the chassis frame, while the analysis process involved geometry import, meshing, loading conditions, and result evaluation. Overall, our aim was to create a design that maximizes the strength-to-weight ratio of the chassis while ensuring its safety and performance. 
 
KEYWORDS: Chassis, Weight reduction, Design, Analysis, Finite element analysis (FEA). 
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CHAPTER-1 INTRODUCTION 
 
1.1 INTRODUCTION: - 
 
The chassis frame is a critical component of a two-wheeler, providing structural integrity and support for various systems like the engine, gearbox, and suspension. Traditionally, steel has been the conventional material used for two-wheeler chassis frames due to its strength and durability. However, advancements in materials science have introduced alternate materials such as aluminum alloys, titanium, and carbon fiber, which offer higher strength-to-weight ratios and the potential for weight reduction in chassis design. 
A motorcycle frame is a motorcycle's core structure. The frame consists mostly of hollow tubes and serves as a skeleton on which components like the gear box and engine are mounted. Suspension The frame also serves as a support for the suspension system, a collection of springs and shock absorbers that helps keep the wheels in contact with the road and cushions the rider from bumps and jolts. 
The design and analysis of a two-wheeler chassis is an essential aspect of the automotive industry, as it has a direct impact on the vehicle's overall performance and safety. The weight of the chassis is a critical factor in its design, as a lighter chassis can enhance the vehicle's handling, acceleration, and fuel efficiency. However, reducing the weight of the chassis without compromising its strength and stiffness is a challenging task that requires careful consideration of the materials used and their properties. The chassis must be designed to withstand various loads and stresses while ensuring that it meets safety standards and performs optimally. Therefore, designing a lightweight yet robust chassis is a complex process that demands a thorough understanding of mechanical engineering, materials science, and manufacturing expertise. 
One way to achieve weight reduction in two-wheeler chassis is by using alternate materials. The use of alternate materials in the design of two-wheeler chassis frames presents an opportunity to reduce the overall weight of the vehicle, resulting in improved fuel efficiency and performance. Weight reduction is of paramount importance in the automotive industry, as it directly affects critical factors such as acceleration, braking, and handling, which are crucial for the safety and performance of two-wheeler vehicles. 
The design and analysis of two-wheeler chassis frames using weight reduction methods involve the utilization of computer-aided design (CAD) software, such as CATIA V5, to model the chassis geometry, and finite element analysis (FEA) using software like ANSYS to simulate and evaluate the chassis performance under various loading conditions. The analysis results provide valuable insights into the mechanical behavior of the chassis, including stress, displacement, and other performance parameters, which can guide iterative design optimizations to achieve an optimal chassis design with reduced weight while maintaining the required strength and safety standards.Finally, the performance of the designed chassis is evaluated through various testing methods such as static and dynamic load tests, fatigue tests, and vibration tests.        
[image: ] 
                                                   Fig 1.1 Two Wheeler Chassis                               
Overall, the design and analysis of a two-wheeler chassis by weight reduction method using alternate materials is a complex process that requires a multidisciplinary approach involving materials science, mechanical engineering, and manufacturing expertise. However, the benefits of a lighter, stronger chassis can lead to significant improvements in vehicle performance and fuel efficiency. 
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CHAPTER-2 LITERATURE SURVEY 
 
 2.1 LITERATURE SURVEY: - 
 
1. Mr.Inzaman Mulla, Professor A.M.Qureshi,2019 .His project deals with design of two-wheeler chassis frame and its weight optimization. Various loading conditions like static loadings were carried out on the chassis and the structural stability of the chassis is analysed by using alternate material as well as alternate geometry while maintaining the strength. The various materials are studied and the best material will be selected as the solution. The weight optimization is achieved in this project. If we compare stress value of steel with other material then we will get that stress value for steel and aluminium is almost same and stress value is lower for titanium and carbon fiber. 
Titanium and carbon fiber are costly material so we have eliminated these material on cost basis.  
2. Pavana Shireesha Paningipalli,Dr.F.B.Sayyad (2016) together done on theoretical and experimental validation of bike chassis for weight reduction. She worked on CAD model of bike chassis is modelled by using reverse engineering. The forces are calculated and the FEA analysis of conventional model is performed. Natural frequency of the bike chassis is extracted. Bike chassis is analysed for aluminium material and results are interpreted for design safety. Natural frequency of the same are extracted. Aluminium bike chassis is fabricated and tested using FFT analyser. The results of the analytical and the experimental values are compared and validated. The comparative study of both conventional and aluminium model is made. 
3. Darade P.P. done design analysis by using bamboo. After fitment of bamboo columns, the weight of chassis is 13.40 Kg Hence, reduction in weight is about 2.071 Kg so, by using bamboo specimen in the frame we can reduce the cost as well as weight of the overall structure. For protection from water a layer of liquid cement is applied so that water should not react with bamboo specimen. 
4. Prof.H.D.Lagdev done comparative finite element analysis of different materials for bike chassis to reduce weight. This work deals with study of a two wheeler chassis which serves as a skeleton upon which parts like gearbox and engine are mounted. It contributes around 14% in the total vehicle weight. It is thus significant to improve the design of the chassis to provide good balancing and improved fuel efficiency. This work deals with the performance improvement of the existing chassis of a two wheeler with certain design changes (trying different materials).Aluminum alloy 6063 is used to replace the existing Mild Steel material and study the results. Analysis is done under static loading conditions. The loads studied are tank load, engine load, rider load & pillion load. From this proposed study, it is expected that the chassis with alternate material is performing better with a satisfying amount of reduction and the weight reduction will hence lead to better fuel efficiency of the vehicle without disturbing strength of chassis. 
5. K.S.Sunil (2015) done on optimization two wheeler chassis. This paper, deals with the development of bike chassis using reverse engineering and optimized the same with FEM. The simulation predicts the stress distribution, displacement and natural frequency. The weight optimization of the chassis plate, i.e. which is used to mount the engine was done.In the optimization the weight of the chassis plate was reduced by 10.28%.Further for the visualization of the model, rapid prototyping technology called fused deposition modelling (FDM) was used to produce prototype of the chassis. 
6. Mikel Burgui Oyaga, 2015 the objective of this project is to establish a method of calculation for designing a chassis of a motorbike in a manner in which can be measured all the parameters that are related to the design to get a chassis as light, strong and economical as possible, taking into account that the time available is limited. The first and most important conclusion he observed is that there is no method completely automatable to design and calculate a chassis. Also by removing some material, could be got lighter chassis and the results would continue being available. Other option could be change some bars for other with lower diameters and thickness. 
7. Chien-Ping Chung done analysis of two wheeler chassis Parameters decision for products that can effectively reduce costs and enhance quality plays an important role in product competitiveness. The simulation processes of the experimental design used the response surface methodology (RSM), and then conducted data analysis to determine the optimal response surface according to the successful application of statistical analysis results. This study simulated product assembly functions by experimental design, and proposed solutions for product parameters. This study took the BBD experimental matrix method of RSM, which has the merit of appropriate experiment frequency, and then, applied mathematics programming software to acquire the optimal solution model. By simultaneously applying RSM and mathematical programming, it is possible to acquire the strengths of both these methods. This study presents a new method to determine design parameters of products, which can lower unnecessary cost expenditures and achieve higher efficiency, thus, enhancing the competitive power of manufacturers and leading to higher profits. 
8. K.Sivaramakrishnan done on design and analysis of two wheeler chassis. structural analysis of the different materials has be done by using stainless steel, aluminium alloy, carbon steel, titanium must be done using ANSYS software. From the result it is observed that the stresses are maximum at the joint location and also for all the materials the stress value values are less that their permissible yields stress values. So the design is safe. While comparing the all four material steel and aluminium are cheapest in cost but as for our result the stress and deformation must be lesser in stainless steel and carbon steel. By using carbon steel it has less density compared to stainless steel materials and also cheap in cost, so this is the best suitable material for chassis frame and is expected to perform better with satisfying amount of weight reduction. 
9. Kedar Sudhir Naik(2020) done analysis and optimization of two wheeler chassis for weight reduction. This paper deals with the analysis of selected two wheeler chassis of Yamaha FZ v2 for modal analysis. From the results he concluded that from the selected alternative materials aluminium can be the alternative for steel. By using it we can reduce the weight of vehicle. By doing this weight reduction we can increase the fuel efficiency of vehicle. 
10. Jakub Smiraus done significant breakthrough in motorcycle chassis design took place at the end of 90s, when new materials, e.g. aluminium alloy or various composites, were utilized. This brought about up-to-now unprecedented strength while sustaining or even decreasing weight of particular parts. It was then, when development of fast yet perfectly controllable and safe motorcycles was made possible. Modern motorcycles have a number of electronic systems supporting their driving stability. However, the idea of  trying to affect the driving stability with the use of up-to-now changeless parameters such as wheelbase or trail new. 
 
11. Mohammad Shiblee Khan(2021) done on optimization of two wheeler chassis for weight reduction. He concluded that, the analysis done on two wheeler chassis frame for different materials shows significant force differences; while modifying the chassis considering weight reduction will lead to increase fuel efficiency. It is more suitable to use carbon epoxy material for two wheeler chassis frame as it seen to be safe for static and shocks load. Geometrical parameters tends to change dynamics on vehicle, Tubular frame structure shows more deformation and stresses as compare to beam frame during acceleration but shows contradiction during braking operation. To reduce vehicles weight it is more suitable to use carbon epoxy with rectangular cross section in suspension frame. 
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CHAPTER-3 CHASSIS 
3.1 CHASSIS:- 
A chassis is the main structural framework that forms the foundation of a vehicle, providing support, strength, and stability to the entire vehicle. It serves as the backbone upon which all other components, such as the engine, transmission, suspension, wheels, and body, are attached or mounted. The chassis plays a critical role in determining the overall performance, safety, and durability of a vehicle. 
There are various types of chassis designs that can vary depending on the type of vehicle, its intended use, and manufacturing standards. Common types of chassis include body-on-frame, unibody or monocoque, space frame, and ladder frame, each with its own advantages and applications. 
Materials used in chassis construction typically include steel, aluminium, or other materials that offer a good balance between strength, weight, and cost. The design and construction of the chassis are meticulously engineered to provide optimal structural integrity, durability, and performance. 
The chassis also incorporates various features such as suspension mounts, engine mounts, fuel tank mounts, exhaust mounts, and other attachments, depending on the specific requirements of the vehicle. Proper chassis design and construction are crucial for ensuring proper handling, stability, safety, and overall performance of the vehicle. 
In summary, the chassis of a vehicle serves as the foundation that supports and connects all major components, providing the necessary strength, stability, and structural integrity for safe and efficient operation. It plays a critical role in determining the performance, safety, and durability of the vehicle and is carefully engineered using suitable materials and designs to ensure optimal performance. 
 
       
 
 

         Fig 3.1.1 Four Wheeler Chassis                           Fig 3.1.2 Two Wheeler Chassis 
 
3.2 PRINCIPLE OF CHASSIS:- 
 
The chassis is the structural foundation of a vehicle, providing the support and framework for its various systems and components. The fundamental principle of the chassis is to deliver a stable and secure platform for the vehicle's powertrain, suspension, and steering elements. Its design ensures that the vehicle's weight is distributed evenly across the frame, promoting a balanced posture during operation and enhancing stability. 
Moreover, the chassis must absorb and dissipate the forces generated during vehicle operation, such as acceleration, braking, and cornering forces. To maintain vehicle safety, it must be durable enough to withstand these forces without compromising stability or producing excessive vibrations or oscillations. 
Another vital aspect of the chassis is its role in maintaining the vehicle's suspension geometry. The suspension system relies on the chassis to preserve its alignment and geometry, which are crucial for handling, stability, and comfort. 
In summary, the principle of the chassis is to create a durable, stable, and robust platform that supports the vehicle's various systems and components, absorbs and dissipates forces generated during operation, and maintains the vehicle's balance, stability, and handling characteristics. 
 
3.3 MATERIAL USED FOR CHASSIS:- 
 
The material used for the chassis of a two-wheeler plays a vital role in determining its overall strength, weight, durability, and safety.Some of the most commonly used materials are: 1.Steel 
2.Aluminium 
3.Titanium 
4.Carbon fiber 
5.Magnesium 
The selection of materials for a chassis depends on several factors, including the intended use of the vehicle, performance requirements, and budget constraints. Each material offers its own set of advantages and disadvantages, and the designer must weigh these factors to choose the most appropriate material for the chassis. 
For instance, if the goal is to create a lightweight and high-performance vehicle, materials like carbon fiber or titanium may be considered. On the other hand, if the priority is affordability, traditional materials like steel or aluminium may be the preferred choice. 
Other factors, such as ease of manufacturing and availability, also influence the material selection process. For example, steel is a commonly used material due to its relatively low cost, high strength, and ease of fabrication. Aluminium, while more expensive than steel, offers better weight reduction and corrosion resistance. 
Ultimately, the material selection process involves a trade-off between cost, weight, strength, and other factors. The designer must carefully consider these trade-offs to select the most appropriate material for the chassis that meets the requirements of the vehicle and its intended use. 
 
3.4 TYPES OF CHASSIS:- 
1.Backbone chassis 
2.Single cradle chassis 
3.Double cradle chassis 
4.Perimeter Chassis 
5.Trellis chassis 
6.Monocoque chassis 
 
3.4.1 SPLINE OR BACKBONE CHASSIS:- 
 
This frame allows flexibility to system as single wide beam used to mount engine on it. It acts as a core structure. The backbone chassis is a vehicle frame design commonly found in motorcycles, scooters, and other two-wheeled vehicles. This chassis is named for its characteristic shape, which resembles a spine that runs down the centre of the vehicle. 
A backbone chassis consists of a large, single tube that runs from the steering head to the rear wheel axle, serving as the primary structural support for the vehicle. This tube is typically constructed from steel or aluminium and provides a mounting point for critical components such as the engine, suspension, and fuel tank. 
[image: ] 
Fig 3.4.1 Spline Chassis 
 
3.4.2 SINGLE CRADLE CHASSIS:- 
 
A single cradle chassis, also referred to as a single downtube or diamond frame, is a popular frame design that is commonly used in budget-friendly motorcycles. It features a smaller diameter steel tube that forms a cradle around the engine, with a main tube running along the top and base for support. The design mimics that of a bicycle chassis, with two tubes connecting the steering head or yoke. The single cradle chassis is a lightweight and simple design that is suitable for smaller motorcycles. In contrast, double cradle frames are used mostly in off-road vehicles, and they feature a cradle that surrounds the engine and splits into two separate cradles at the exhaust. 
[image: ] 
Fig 3.4.2 Single Cradle Chassis 
 
3.4.3 DOUBLE CRADLE CHASSIS:- 
 
A double cradle chassis is a type of vehicle frame that is commonly used in motorcycles, particularly off-road bikes. It consists of two large tubes that run from the steering head to the rear wheel axle, forming two cradles on either side of the engine. This design provides additional support and stability to the vehicle, which is particularly useful when riding on rough or uneven terrain. 
[image: ] 
Fig 3.4.3 Double Cradle Chassis 
 
3.4.4 PERIMETER CHASSIS:- 
 
The perimeter frame, also known as the twin-spar frame, is a popular choice for performance-based motorcycles. This frame design was developed based on research conducted on motorcycle racing, which found that a shorter distance between the steering head and swingarm pivot results in increased rigidity. The rods connecting the two should be sufficiently stiff, and a decrease in weight also improves the results. 
The twin-spar frame consists of two beams, or spars, that extend from the steering head and surround the engine, reaching out to the swingarm pivot. This design provides a high level of structural rigidity, which helps to improve handling and stability at high speeds and during aggressive manoeuvres. 
[image: ] 
Fig 3.4.4 Perimeter Chassis 
 
3.4.5 TRELLIS CHASSIS:- 
 
A trellis frame is a type of vehicle frame commonly used in motorcycles and other two-wheeled vehicles. It is made up of a large number of short steel or aluminium tubes welded together to form a series of triangles, creating a lightweight and stiff structure. 
The trellis frame is designed to connect the steering head to the swingarm, similar to the perimeter frame. However, instead of two large beams reaching out to the pivot arm, the trellis frame uses a network of smaller tubes arranged in a lattice or trellis-like pattern. 
 
 
[image: ] 
Fig 3.4.5 Trellis Chassis 
 
3.4.6 MONOCOQUE CHASSIS:- 
 
The monocoque frame, like the perimeter frame, relies on external mountings to support the load. However, the manufacturing process for the monocoque frame is highly capital-intensive and requires advanced robotization for production. This makes it a less viable option for most bike makers. Monocoque frames are typically used in high-performance motorcycles with extremely high power figures. The structure is a single, super-stiff piece made from the lightest and stiffest materials available, such as carbon fiber and magnesium. 
                          
[image: ] 
Fig 3.4.6 Monocoque Chassis 
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CHAPTER-4 ALTERNATE MATERIAL 
 
4.1 SELECTION OF  ALTERNATE MATERIAL:- 
 
The traditional material used in the design and analysis of two wheeler chassis is steel, but in recent years, there has been a trend towards using alternate materials to improve the performance and reduce the weight of the chassis. Some of the alternate materials that are being used in the design and analysis of two wheeler chassis include: 
Steel:Steel is a common material used in the design and analysis of two wheeler chassis due to its strength, stiffness, and durability. It is also widely available and relatively inexpensive. The properties of steel can be manipulated by adding different alloying elements, which can increase its strength, ductility, and corrosion resistance. 
Aluminium: Aluminium is a lightweight material that has high strength to weight ratio. It is also corrosion-resistant and can be easily formed and machined. These properties make it an attractive material for the design and analysis of two wheeler chassis. 
Titanium: Titanium is another lightweight material that has high strength and excellent corrosion resistance. It is more expensive than steel and aluminium, but its unique properties make it an attractive material for high-performance applications. 
Carbon fiber:It is reinforced polymer (CFRP): CFRP is a composite material that consists of carbon fibers and a polymer resin. It is lightweight, strong, and stiff, and has excellent fatigue resistance. These properties make it an attractive material for high-performance two wheeler chassis. 
When selecting an alternate material for the design and analysis of a two wheeler chassis, it is important to consider the material's properties, such as strength, stiffness, weight, corrosion resistance, and cost. The material should also be compatible with the manufacturing processes used to produce the chassis, and should meet the required safety standards and regulations. 
 
4.1.1 STEEL:- 
Steel is an alloy made primarily from iron and carbon, with small amounts of other elements such as manganese, silicon, and phosphorus. The amount of carbon in steel typically ranges from 0.2% to 2.1%, with higher carbon content resulting in stronger and harder steel. Steel is a versatile and widely used material due to its strength, durability, and relatively low cost. 
There are several different types of steel, each with different properties and uses. Some of the most common types of steel include: 
Carbon steel: Carbon steel is a type of steel that contains mostly carbon and small amounts of other elements. It is the most commonly used type of steel due to its affordability and versatility. 
Alloy steel: Alloy steel is a type of steel that contains additional alloying elements such as manganese, nickel, and chromium. These elements are added to improve the strength, hardness, and toughness of the steel. 
Stainless steel: Stainless steel is a type of steel that contains chromium, which gives it excellent corrosion resistance. It is commonly used in applications where resistance to corrosion is critical, such as in the food industry and medical equipment. 
Tool steel: Tool steel is a type of steel that is specifically designed for use in cutting and shaping tools. 
It is characterized by its hardness and ability to retain a sharp edge. 
When selecting steel for a particular application, it is important to consider the material's properties, such as strength, ductility, toughness, and corrosion resistance. The manufacturing process used to produce the steel can also affect its properties, such as the presence of impurities and the heat treatment used to alter the material's microstructure. 
 
PROPERTIES 
 
· Strength: Steel is a strong material that can withstand high loads and stresses. The strength of steel can be increased by adding alloying elements or by heat treatment. 
· Durability: Steel is a durable material that is resistant to wear, corrosion, and fatigue. Its durability makes it suitable for use in structures and machines that need to withstand harsh environments and frequent use. 
· Ductility: Steel is a ductile material, meaning that it can be deformed without fracturing. This property makes it suitable for forming and shaping into a variety of shapes and structures. 
· Toughness: Steel is a tough material that can absorb and dissipate energy without fracturing. Its toughness makes it suitable for use in applications that are subjected to impacts and vibrations. 
· Machinability: Steel is a machinable material that can be easily shaped, drilled, and cut. This property makes it suitable for use in manufacturing processes that require precise shapes and sizes. 
· Weldability: Steel is a weldable material that can be joined together using various welding techniques. This property makes it suitable for use in structures and machines that require strong and durable joints. 
· Corrosion resistance: Some types of steel, such as stainless steel, are highly resistant to corrosion. This property makes them suitable for use in applications where exposure to moisture or corrosive substances is likely. 
 
4.1.2 ALUMINIUM:- 
 
Due to its low density, high strength, and exceptional resistance to corrosion, aluminium has become a favoured material for constructing chassis. Its widespread use can be seen in the automotive and aerospace industries, as well as in the production of bicycles, boats, and other high-performance vehicles. 
Aluminium alloys that are utilized for building chassis are typically chosen for their combined strength, toughness, and ductility, which enable them to endure the daily wear and tear of use. Furthermore, their lightweight composition contributes to reducing the overall weight of the vehicle and improving fuel efficiency. 
PROPERTIES 
· Low density: It has a low density, which makes it lightweight and easy to handle. 
· High strength :It has a high strength-to-weight ratio, making it strong and sturdy despite its low density. 
· Corrosion resistance: It has excellent resistance to corrosion, making it ideal for use in environments where exposure to moisture or other corrosive substances is a concern. 
· Ductility: It is highly ductile, which means it can be easily formed into different shapes and sizes without breaking. 
· Thermal conductivity: It has good thermal conductivity, which means it can quickly transfer heat and dissipate it. 
· Electrical conductivity: It has good electrical conductivity, which makes it useful for electrical applications. 
· Reflectivity: It has a high reflectivity of both light and heat, making it useful in reflective applications such as mirrors and thermal insulation. 
· Recyclability: It is 100% recyclable and can be reused indefinitely without losing its properties or performance. 
 
4.1.3 CARBON FIBER:- 
 
Due to its high stiffness and strength-to-weight ratio, carbon fiber has become a favoured material for constructing two-wheeler chassis. It is widely used in the production of high-performance motorcycles and bicycles, as it offers many advantages over conventional materials such as steel or aluminium. 
Carbon fiber composites are composed of sturdy carbon fibers that are embedded in a polymer matrix, which contributes to their exceptional properties. The carbon fibers are remarkably strong and rigid, while the polymer matrix provides exceptional durability and resistance to impacts. 
 
PROPERTIES 
 
· High strength-to-weight ratio: Carbon fiber is incredibly strong and lightweight, which allows for the creation of strong and durable chassis that weigh significantly less than those made of other materials. 
· Stiffness: Carbon fiber is highly rigid, which helps to reduce flexing or bending of the chassis, improving handling and stability. 
· Fatigue resistance: Carbon fiber is highly resistant to fatigue, which allows the chassis to withstand constant stress and strain over a long period of time. 
· Corrosion resistance: Carbon fiber is highly resistant to corrosion, making it ideal for use in environments where exposure to moisture or other corrosive substances is a concern. 
· Customizability: Carbon fiber can be customized to create complex shapes and designs that are tailored to specific performance requirements, which can improve aerodynamics, weight distribution, and overall performance. 
· Electrical conductivity: Carbon fiber is electrically conductive, which can be useful for certain applications where electrical conductivity is required. 
 
 
4.1.4 TITANIUM:- 
 
Due to its exceptional properties, titanium is occasionally utilized in the construction of highperformance two-wheeler chassis. This lightweight and robust metal provides numerous advantages over conventional materials such as steel or aluminium. 
Titanium's strength-to-weight ratio is one of its primary advantages. It is lighter than steel, yet has comparable strength, allowing a titanium chassis to provide adequate structural support while keeping the overall weight of the vehicle low. This can improve acceleration, fuel efficiency, and handling. 
 
PROPERTIES 
 
· High strength-to-weight ratio: Titanium is one of the strongest and lightest metals available, which makes it an ideal material for constructing lightweight but strong chassis. 
· Corrosion resistance: Titanium is highly resistant to corrosion, even in harsh environments, which makes it a durable choice for two-wheeler chassis. 
· High fatigue strength: Titanium can withstand repeated stress and strain without cracking or breaking, which can prolong the lifespan of the chassis. 
· Biocompatibility: Titanium is biocompatible, meaning it does not react with human tissue, making it a suitable material for use in medical implants. This property also means that titanium chassis can be a good choice for riders who may have allergies or sensitivities to other materials. 
· Low thermal expansion: Titanium has a low coefficient of thermal expansion, meaning it does not expand or contract significantly with changes in temperature. This property can help ensure the chassis maintains its shape and structural integrity over time. 
· Excellent damping properties: Titanium has good damping properties, meaning it can absorb 
vibrations and reduce the risk of fatigue failure in the chassis. 
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CHAPTER-5 INTRODUCTION TO CAD 
 
5.1 INTRODUCTION:- 
 
COMPUTER AIDED DESIGN(CAD) is an advanced technology that enables designers and engineers to use computer software for creating, editing, analysing, and optimizing designs. CAD has found widespread applications in various industries such as engineering, architecture, automotive, aerospace, and manufacturing. 
With CAD software, designers can develop both 2D and 3D models of products and structures, which can be used for visualization, technical analysis, and simulations. CAD models can be easily modified and manipulated, allowing designers to test different design alternatives and make improvements before creating physical prototypes. 
One of the significant advantages of CAD software is its ability to automate many of the design and drafting processes, making them faster and more efficient than traditional manual methods. This leads to reduced design time and costs, improved accuracy, and fewer errors. 
CAD software is versatile and can be used to design a wide range of products, including mechanical parts, buildings, electrical systems, and even fashion and jewelry. It is a powerful tool for designers and engineers, providing them with the ability to bring their ideas to life quickly and accurately. 
It also provides various tools to help us productively start, edit and complete the design needed for the user. Easy and simple drawings and models can be produced without much effort. It has various and wide range of uses from different departments and inclusion or inculcation of computers also makes it much more efficient than conventional one. 
 
Its use in designing electronic systems is known as electronic design automation (EDA). In mechanical design it is known as mechanical design automation (MDA), which includes the process of creating a technical drawing with the use of computer software. 
CAD software for mechanical design helps drafting, and designing in 2D space with software’s such as AUTOCAD 2D, in 3D space software’s such as CATIA V5, SOLIDWORKS, FUSION 360, 
AUTOCAD 3D etc., 
[image: ] 
Fig 5.1.1 CAD 
[image: ] 
Fig 5.1.2 2-D,3-D Drafting 
 
CAD software’s also provide services in production planning and also in manufacturing fields known as Computational Numerical Control(CNC) where Numeric and special symbols are used and a code is written which is machine understandable and manufactures required product. Software are also build in such a way that a design can directly be converted into code. CAD is also widely used to produce computer animation for special effects in movies, advertising and technical manuals, often called DCC digital content creation. 
Manufacturing is again classified into two types namely: 
i) Subtractive manufacturing ii) Additive Manufacturing 
Subtractive Manufacturing:  
In this type of manufacturing technique a required product is produced by removal of additional material from a raw product. Manufacturing of a material using CNC machines comes under this category. As material is being removed from the raw material it is termed as Subtractive Manufacturing. 
Additive Manufacturing:  
In this type of manufacturing technique a required product is produced by addition of layers of material on upon another. Manufacturing of material using 3D Printing comes under this category. 3D Printing is one of the most booming skill and value in today’s world that has been upgrading and improving day to day and now is able to produce even complex shapes that are difficult to manufacture using Subtractive technique. Fusion 360 is used for designing and directly manufacturing materials using 3D printing. 
5.2 INTRODUCTION TO CATIA V5R20:- 
                  
[image: ] 
Fig 5.2.1 Catia Logo 
CATIA V5 R20 is a computer-aided design (CAD) software developed by Dassault Systems. It is the 20th release of the CATIA V5 software and is widely used in various industries such as aerospace, automotive, and manufacturing. 
CATIA V5 R20 offers advanced capabilities for 3D modelling, simulation, and analysis, allowing designers and engineers to create highly complex designs with greater accuracy and efficiency. It also features an intuitive user interface that makes it easier for users to navigate and access its various tools and functions. 
With CATIA V5 R20, users can create and modify 3D models using a range of design tools, such as wireframe, surface, and solid modelling. It also offers advanced capabilities for assembling and manipulating components and sub-assemblies, as well as simulation and analysis tools for testing and optimizing designs. 
Other notable features of CATIA V5 R20 include its ability to handle large assemblies, support for multi-CAD environments, and integration with other Dassault Systems software such as SIMULIA for advanced simulation and analysis. 
Overall, CATIA V5 R20 is a powerful and versatile CAD software that provides designers and engineers with the tools they need to create highly complex designs quickly and accurately. 
 
5.3 FEATURES:- 
 
· Advanced 3D Modelling: CATIA V5 R20 offers a range of tools for creating and modifying 3D models, including wireframe, surface, and solid modelling. This allows designers to create highly complex designs with greater accuracy and efficiency. 
· Assembly Design: CATIA V5 R20 offers advanced capabilities for assembling and manipulating components and sub-assemblies. It allows users to easily create and manage complex assemblies, including those with thousands of parts. 
· Simulation and Analysis: CATIA V5 R20 provides powerful simulation and analysis tools for testing and optimizing designs. It includes capabilities for finite element analysis (FEA), kinematics simulation, and other types of analysis. 
· Large Assembly Management: CATIA V5 R20 can handle large assemblies with ease, making it well-suited for complex projects. It provides features for managing large assemblies, such as simplified representations, configurations, and performance optimization. 
· Multi-CAD Support: CATIA V5 R20 can work with data from other CAD systems, making it well-suited for multi-CAD environments. It provides tools for importing and exporting data from other systems, as well as for managing data translation and quality. 
· Integration with Other Software: CATIA V5 R20 integrates with other Dassault Systems software, such as SIMULIA for advanced simulation and analysis, and ENOVIA for collaborative design and data management. 
· Intuitive User Interface: CATIA V5 R20 features an intuitive user interface that makes it easy for users to navigate and access its various tools and functions. It provides customizable toolbars and menus, as well as contextual help and documentation. 
Overall, CATIA V5 R20 is a comprehensive CAD software that provides designers and engineers with the tools they need to create highly complex designs quickly and accurately. 
5.4 TOOLS:- 
CATIA V5R20 is a 3D CAD software widely used in industries such as aerospace, automotive, and manufacturing. It has a wide range of tools and features that enable designers and engineers to create complex 3D models and assemblies. Some of the commonly used tools in CATIA V5R20 are: 
· Part Design: This tool is used for creating 3D solid models of parts. It has various features such as sketcher, pad, pocket, hole, fillet, and chamfer. 
· Assembly Design: This tool is used for creating complex assemblies by assembling various parts together. It has features such as constraints, joints, and kinematics. 
· Drafting: This tool is used for creating 2D drawings of 3D models. It has features such as views, dimensions, annotations, and tables. 
· Generative Shape Design: This tool is used for creating complex surfaces and shapes. It has features such as extrude, revolve, sweep, and blend. 
· Wireframe and Surface Design: This tool is used for creating wireframe and surface models. It has features such as curve, surface, and boundary. 
5.5 CATIA INTERFACE:- 
[image: ] 
Fig 5.5.1 Catia Interface 
5.5.1 SPECIFICATION TREE:- 
 
[image: ] 
Fig 5.5.2 Specification Tree 
 
· The specification tree is displayed on the left side of the screen while you are working. 
· Provides access to the history of how a part was constructed and shows the product structure. 
· Product entities can be selected from the specification tree or in the geometry are. 
· Parts can be modified by selecting them from the specification tree. 
· Click on + to open a tree branch. 
· Solid parts are stored in the PartBody branch of the part. 
 
5.5.2 MOUSE CONTROLS:- 
· Pan:  Press and hold the middle mouse button and move the mouse to pan. 
· Rotate: Press and hold the middle mouse button then the left mouse button and move the mouse to rotate. 
· Zoom: Press and hold the middle mouse button and click the left mouse button then move the mouse to zoom in and out. 
· Using the compass 
[image: ] 
Fig 5.5.3 Compass 
· Drag the aces or planes of the compass to dynamically rotate the display. 
· Multi-select entities by holding down the Shift key. 
 
5.5.3 VIEW TOOLBAR:- 
[image: ] 
Fig 5.5.4 View Tool Bar 
In CATIA V5 R20, the View Toolbar provides a set of tools to manipulate and view the 3D models. The View Toolbar is located at the top of the screen by default, below the main menu. Here are some of the tools available on the View Toolbar: 
· View Selector: Allows you to select a specific view orientation, such as top, front, or right. 
· Zoom In/Out: Allows you to zoom in or out of the 3D model. 
· Pan: Allows you to move the 3D model in the viewport. 
· Rotate: Allows you to rotate the 3D model in the viewport. 
· Fit All in Window: Allows you to fit the entire 3D model in the viewport. 
· Isometric View: Allows you to set the view orientation to an isometric view. 
· View Cube: Allows you to manipulate the 3D model by clicking on the view cube. 
· Compass: Shows the current orientation of the 3D model. 
· Dynamic Sectioning: Allows you to cut away a section of the 3D model to see the internal details. 
· Save View: Allows you to save a specific view orientation for future use. 
 
5.5.4 SKETCHER MODULE:- 
 
The Sketcher workbench is a set of tools that helps you create and constrain 2D geometries. Features (pads, pockets, shafts, etc...) may then be created solids or modifications to solids using these 2D profiles. You can access the Sketcher workbench in many ways. Two simple ways are by using the top pull down menu (Start – Mechanical Design – Sketcher), or by selecting the Sketcher icon. When you enter the sketcher, CATIA requires that you choose a plane to sketch on. You can choose this plane either before or after you select the Sketcher icon. To exit the sketcher, select the Exit Workbench icon.  
The Sketcher workbench contains the following standard workbench specific toolbars: 
[image: ] 
Fig 5.5.5 Sketcher Module 
 
5.5.5 PART DESIGN MODULE:- 
Part design environment is used to create 3D models from the basic 2D sketches created in sketcher environment. 
[image: ] 
Fig 5.5.6 Part Design Module 
 
5.5.6 ASSEMBLY MODULE:- 
Assembly environment is used to provide mating to two or more part models to from complete assembly. 
[image: ] 
Fig 5.5.7 Assembly Module 
 
5.5.7 DRAFTING MODULE:- 
Drafting is a process of generating 2D machine drawing for the 3D part models to send it to the manufacturer's. 
Catia drafting is of two types 
1.Interactive Drafting 
2. Generative Drafting 
	[image: ]	 
Fig 5.5.8 View Tool Bar & Automatic Dimension Creation 
[image: ] 
Fig 5.5.9 Geometry, Transformation, Relimitations and Annotation tool bar 
[image: ] 
Fig 5.5.10 Dimensions and Dress up tool bar 
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CHAPTER-6 
INTRODUCTION TO F.E.A. 
 
6.1 INTRODUCTION:- 
 
The finite element method has been a powerful tool for the numerical solution of a wide range of engineering problems. Application range from deformation and stress analysis of automotive, aircraft, building, defense, missile, and bridge structures to the field analysis of dynamics, stability, fracture mechanics, heat flux, fluid flow, magnetic flux, seepage and other flow problems. With the advances in computer technology and CAD systems Complex problems can be modeled with relative ease. Several alternate configurations can be tried out on a computer before the first prototype is built. The basics in engineering field is must to idealize the given structure for the required behavior. The proven knowledge in the typical problem area, modeling techniques, data transfer and integration, computational aspects of the finite element method is essential. 
In many cases, it is difficult to determine the behaviour of complex continuous systems without using some form of approximation. While classical solutions can be found for simple members like uniform beams and plates by forming differential and/or integral equations, structures like machine tool frames, pressure vessels, automobile bodies, ships, aircraft structures, and domes require some sort of approximate treatment to determine their static deformation, dynamic properties, or heat conducting property. These structures have continuously distributed mass and elasticity, making the classical differential equation solution approach intractable. To overcome this, engineers and mathematicians have proposed using discretization methods, where complex structures are defined using a finite number of well-defined components, and are then treated as discrete systems. The discretization method can involve using finite difference approximations or various residual procedures, among others. By using these methods, it becomes possible to approximate the behaviour of complex systems and determine their properties more easily. 
The finite element method is a type of discretization method that was first used by R.W. Clough in the 1960s. Although the method requires a large number of computations and a fast computer, digital computer advances have allowed for its expanding usage. Initially, the finite element method was developed to solve structural problems, but since then, it has been rapidly extended to various fields. Over time, there has been significant progress made in the method, and it has become an important tool in solving complex problems. Its versatility and ability to handle a wide range of problems have made it increasingly popular in many different fields 
 
6.2 INTRODUCTION TO FEM:- 
 
In the field of engineering, it is necessary to obtain the unknown field parameters like displacement or forces, which can describe the behavior of structures. These unknowns can be obtained by using exact analytical solutions or energy methods, which are formulated with governing equilibrium equations of analytical solutions on the basis of solid mechanics. However in practice the real structure viz., aircraft/automobiles, civil, naval architecture, offshore and nuclear engineering are large in size with irregular shapes, intermediate in nature, possessing geometrical material non-linearity and having complicated loading or boundary conditions. 
In these cases, to reduce the continuous system to a discrete one by conventional method, a lot of effort and assumption must be made,which are cumbersome and error prone.The advent of high speed electronic computer has given tremendous opportunity to the numerical method approach. The most commonly used numerical technique in solving engineering problems is FEM,because 
1. Algebraic work corresponding to the solid mechanics is programmed in systematic matrix calculations and formulated into mathematical model. User need not work with complicated algebra but only to deal with the discredited geometry of the physical structural. 
2. Ability to consider alternate loading and bending condition for the same geometry. 
3. Accuracy of data mainly depends on the number of approximations. 
 
The given system or structure is divided into small elements of units interconnected at grid points. Each element is solved variable, inherently making use of classical procedures and analytical. This process of breaking down of continuum of finite discrete elements and solving for the variable (velocity, displacement, stress and loads etc) is called finite element analysis. 
The two methods used for the analysis of a problem in FEM are: 
(a) Force method: Here the forces are unknown (minimum complimentary energy method) 
(b) Displacement Method: Here the displacements are unknown (minimum potential energy method) 
6.3 STEPS INVOLVED IN FEM:- 
 
The basic steps involved in finite element method are as follows. 
1. Modelling: The basic idea of finite element modelling is to discretize the region and expresses the displacement in terms of values at discrete points. 
2. Discretization:  Discretization means division of a given structure into finite number elements of better approximations. This forms the first step in the analysis of complicated structural system. 
3. Formulation of elemental equation and convergence test: 
The properties of the elements are formulated and combined to obtain the solution for the entire body or structure. For e.g. in the displacement formulation widely adopted in FE analysis, simple functions known as shape functions are chosen to approximate the variation of the displacement at the nodes of the element. 
Convergence test is done to know that how much the approximate solution converges to the exact value and the errors are calculated. 
4. Determination of 
a. Elemental stiffness matrix [Ke] 
b. Elemental nodal displacement vector [Q] 
c. Elemental load vector [F] 
5. Equilibrium equations are imposed so that each of the elements is in a state of Equilibrium 
     [Ke] [Qe] = [Fe] 
6.Assembly of 
a. Stiffness matrix of all the elements [K] 
b. Nodal displacements of all the elements [Q] 
c. Nodal forces of all elements [f] 
d. Overall stiffness matrix formed by global addition of element stiffness matrices. 
7.Assembled Equilibrium Equation 
The equation of equilibrium for the entire structure of body is then obtained by combining the equilibrium equation of each element such that the continuity of displacement is ensured at each node where the elements are connected. 
[K] [Q] = [F] 
8.Application of boundary conditions to the overall equilibrium equation. 
The necessary conditions are imposed and the equations of equilibrium are solved for the nodal displacements.  
There are two approaches of applying the boundary conditions. 
a. Elimination technique 
In this technique after imposing the boundary conditions, whichever displacement is Zero, the corresponding row and column of the overall equilibrium is eliminated. 
b. Penalty approach 
Second approach for handling boundary condition is the penalty approach. This approach easily implemented in a computer program and retains its simplicity even when considering general boundary conditions where a large value of C is added to the highest diagonal elements. On applying the boundary conditions, the overall equilibrium equation gets modified. 
c. Solution of the modified overall equilibrium equation by gauss elimination method 
 The value of nodal displacements will be obtained in this step. Thus knowing of all the nodal displacements, stain of each element will be computed.  
From these values elemental stresses are obtained. 
Computation of Strains: 
For each element strain calculated is given by the overall equation 
[ε] = {b} {q} 
Where,  
[ε]= Strain Matrix 
{b} = Strain Displacement Matrix where be is unique for each element 
 (q) = Elemental Nodal Displacement Vector. 
 
6.4 MERITS OF FEM:- 
The merits of finite element method are: 
· The systematic generality of finite procedure makes it a powerful and versatile tool for a wide range of problems. Thus flexible, general-purpose computer programs can be developed and can be applied to various problems with little or no modification.  
· FEM can be easily interpreted in physical terms and it has a strong mathematical base. Hence, finite element method can be easily applied to any problem with a proper knowledge of the physical system under consideration and can be solved to a greater accuracy by the application of proper mathematical tool. 
· Non-homogeneous continuum can also be dealt with by merely assigning different properties to different elements. It is even possible to vary the properties within an element according to the polynomial applied. 
· Finite element method accommodates complex geometry with ease and is capable of handling non-linear and time dependent system also. 
 
6.5 LIMITATIONS OF FEM:- 
 
· FEM has been developed as a very high solution technique. However, the solution obtained from FEM can be realistic if and only if the material properties are known precisely. 
· The major drawback of FEM is sensitivity of the solution on the geometry of the element such as type, shape and orientation of elements used.The computed programs yield a large amount of data as results it is very difficult to separate out the required results from the pile of numbers. 
6.6 INTRODUCTION TO ANSYS:- 
Ansys has been founded in 1970 and incorporated in 1994. Ansys predominantly offers engineering simulation software and ancillary services. The solutions provided by the company are used in a wide range of industries including aerospace, defense, automotive, biomedical and other industrial sectors. 
 Ansys has been recognized as one of the world's most innovative companies by prestigious publications such as Bloomberg Businessweek and FORTUNE magazine for its engineering simulation software. 
[image: ] 
Fig  6.6.1 Ansys Logo 
Ansys leverages the power of today's desktop computers to provide a common platform for product development, from design concept to final-stage testing and validation. The company's product portfolio consists of simulation platform offerings that are used in diverse multi-physics fields such as heat transfer, fluid mechanics, statics, and solid mechanics. 
The mainstay of Ansys is the Ansys Workbench, which serves as the glue that binds the simulation process. It tracks dependencies among various types of data in the project, ensuring that if something changes in an upstream cell, the project schematic reflects the need to update downstream cells accordingly. This streamlined approach to simulation offers significant advantages to engineers, enabling them to easily manage complex simulations and explore design concepts more efficiently. 
 
6.7 ANSYS SOFTWARE:- 
 
Ansys software suite is designed to handle the complete engineering simulation process, consisting of three main stages: model creation, problem solving, and result analysis. These stages are facilitated by Ansys' pre-processor, solution processor, and post-processor respectively. The pre-processor enables users to create and define geometry, materials, and element mesh. The solution processor allows users to apply loads and obtain solutions to the problem. Finally, the post-processor provides tools for visualization and tabular listing of results. 
Ansys' comprehensive software suite covers a wide range of physics and engineering fields, providing access to virtually any area of engineering simulation required in the design process. With such versatility, organizations worldwide rely on Ansys to deliver the best value for their investment in engineering simulation software. 
[image: ] 
Fig 6.6.2 Ansys Homescreen 
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CHAPTER-7 PROJECT DESIGN 
 
7.1 MODELLING USING CATIA V5R20:- 
 
Modelling of the existing two wheeler chassis will be by using CATIA software and after proper modelling the analysis of system will be done using ANSYS software. General steps involved in design are concept design ,defining dimensions, creating sketches, creating 3D model and assembly design. 
Step-1: 
Open CATIA V5R20 software and check units are in mm.Now click on START➔MECHANICAL DESIGN➔PART DESIGN➔SELECT XY-PLANE.       
[image: ] 
Step-2: 
Before creation of the sketch we have to the dimensions are in mm.Then START➔MECHANICAL DESIGN➔SKETCHER. 
[image: ] 
Step-3: 
The sketch screen opens and double click  the profile icon from the Profile toolbar on the Right Side of the screen. 
[image: ] 
Step-4: 
After creating the user parameters start drawing your sketch.We have to first draw the pipes named A,B,C,D,E,F,G,H,I,J,K,L etc.,Draw line and use rib option to get pipe section with appropriate dimensions. 
[image: ] 
Fig 7.1.1 Sketch Drawing of Chassis 
 
Step-5: 
Draw the remaining pipes with profile and rib tools with appropriate dimensions. 
[image: ] 
 
Step-6: 
Give the curve pipe dimensions and use rib tool bar to get pipe section. 
[image: ] 
Step-7: 
Draw the straight pipe and use rib tool bar to get long tubular section and assemble the two pipes. 
[image: ] 
 
 
Step-8: 
We have to create number of planes to draw the different tubular sections to assemble them. 
[image: ] 
Step-9: 
Assemble all the parts to get the required design by using constraints tool bar. COINCIDENCE 
CONSTRAINT➔CONTACT CONSTRAINT➔OFFSET CONSTRAINT➔ANGLE 
CONSTRAINT➔FIX COMPONENT 
[image: ] 
Step-10: 
Use the mirror command to get the required design of two wheeler chassis. 
SELECT BODY➔TRANSFORMATION TOOLBAR➔MIRROR COMMAND 
[image: ]                                       
Fig 7.1.2 Modeled  And Assembled Two Wheeler Chassis 
Step-11: 
Now we have to save the drawing in .igs or STEP format file to import in ANSYS software. 
CLICK FILE➔SAVE AS➔SELECT AN APPROPRIATE NAME➔SELECT TYPE AS STEP➔CLICK SAVE 
 
[image: ]           [image: ] 
 
       
 
7.2 ANALYSIS OF TWO WHEELER CHASSIS IN ANSYS:- 
 
Chassis considered: Existed chassis Yamaha FZ taken from base paper. 
Engine Load:200N 
Riders weight:2000N 
Fuel Tank Load:200N 
The chassis designed and modelled in CATIA V5R20 is imported to ANSYS and is conducted for Steel,Aluminium,Titanium and Carbon Fibre. 
 
 ALUMINIUM:- 
Step-1: 
First open Workbench 2023 and save the project. From analysis systems drag Static Structural to create standalone system. 
[image: ] 
Step-2: 
In static structural first make sure the right Engineering Data is selected for the analysis i.e., 
ALUMINIUM. 
STATIC STRUCTURAL➔ DOUBLE CLICK ENGINEERING DATA➔ ADD 
ALUMINIUM➔UPDATE PROJECT 
[image: ] 
Step-3: 
Now import the Geometry of chassis modelled in CATIA saved as .igs file. 
STATIC STRUCTURAL➔RIGHT CLICK GEOMETRY➔IMPORT GEOMETRY 
[image: ] 
Step-4: 
Now click on Model.Your model is successfully imported and is ready for analysis. 
Now mesh the model: 
Mesh➔Select the whole body 
Sizing➔Default➔Enter 
Mesh➔Right Click➔Generate Mesh 
(Your mesh is generated) 
[image: ] 
Fig 7.2.1 Meshed Two Wheeler Chassis 
Step-5: 
Now add boundary conditions to the chassis as required: 
1. Static structural➔(Right click)Insert➔Fixed Support➔Select Handle 
2. Static Structural➔(Right Click)Insert➔Force 1➔Magnitude(2000N)➔Direction(-Y Axis) 
3. Static Structural➔(Right click)Insert➔Force 2➔Magnitude(200N)➔Direction(-Y Axis) 
4. Static Structural➔(Right Click)Insert➔Force 3➔Magnitude(200N)➔Direction(-Y Axis) 
[image: ] 
Fig 7.2.2 Boundary Conditions 
Step-6: 
Now start your analysis by adding required type of evaluations. 
1. Solution➔(right click)Insert➔Total Deformation 
2. Solution➔(right click)Insert➔Equivalent Stress 
3. Solution➔(right click)Solve Your analysis is done. 
[image: ] 
 
TITANIUM: 
The chassis designed and modelled in CATIA V5R20 is imported to ANSYS and is conducted for Titanium. 
Steps: 
Now we have to select the Titanium from Engineering Data.Remaining steps are same followed by Aluminium analysis. 
[image: ] 
 
CARBON FIBER:- 
The chassis designed and modelled in CATIA V5R20 is imported to ANSYS and is conducted for Carbon Fibre. 
Steps: 
Now we have to select the Titanium from Engineering Data. Remaining steps are same followed by Aluminium analysis. 
[image: ] 
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CHAPTER-8 RESULTS 
 
8.1 TOTAL DEFORMATION(in mm):- 
Load applied: 
Riders load=2000N 
Engine load=200N 
Fuel tank load=200N 
Total load=2400N 
8.1.1 ALUMINIUM:- 
[image: ] 
 
Finite Element Analysis is done on chassis made by Aluminium and total deformation obtained as 
0.97266mm. 
 
 
8.1.2 TITANIUM:- 
Finite Element Analysis is done on chassis made by Titanium and total deformation obtained as 0.50393mm. 
[image: ] 
 
8.1.3 CARBON FIBER:- 
[image: ] 
Finite Element Analysis is done on chassis made by Carbon fibre and total deformation obtained as 
0.63722mm. 
8.2 EQUIVALENT STRESS OR VON MISSES STRESS(in MPa):- 
Load applied: 
Riders load=2000N 
Engine load=200N 
Fuel tank load=200N 
Total load=2400N 
 
8.2.1 ALUMINIUM:- 
Finite Element Analysis is done on chassis made by Aluminium and Equivalent stress obtained as 
66.431MPa. 
    
[image: ] 
 
 
8.2.2 TITANIUM:- 
 
Finite Element Analysis is done on chassis made by Aluminium and Equivalent Stress is obtained as 64.905MPa. 
[image: ] 
 
8.2.3 CARBON FIBER:- 
Finite Element Analysis is done on chassis made by Carbon fibre and Equivalent Stress is obtained as 153.86MPa. 
[image: ] 
  
8.3 WEIGHT COMPARISION:- 
8.3.1 ALUMINIUM:- 
The mass of chassis is measured as 7.713kg in Ansys as shown in below figure. 
[image: ] 
 
8.3.2 TITANIUM:- 
The mass of chassis is measured as 12.864kg in Ansys as shown in below figure. 
[image: ] 
8.3.3 CARBON FIBER:- 
The mass of chassis is measured as 5.0121kg in Ansys as shown in below figure. 
[image: ] 
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CHAPTER-9 
TABLES & GRAPHS 
9.1 TABLES:- 
 
A. DIMENSIONS:- 
	S.NO 
	PIPE 
	DIMENSION 

	1 
	A 
	O.D=48.30mm,I.D=42.76mm 

	2 
	B 
	O.D=42.2mm,I.D=36.66mm 

	3 
	C 
	O.D=42.2mm,I.D=36.66mm 

	4 
	D 
	O.D=42.22mm,I.D=36.66mm 

	5 
	E 
	O.D=42.22mm,I.D=36.66mm 

	6 
	F 
	O.D=33.4mm,I.D=27.86mm 

	7 
	G 
	O.D=33.4mm,I.D=27.86mm 

	8 
	H 
	O.D=33.4mm,I.D=27.86mm 

	9 
	I 
	O.D=33.4mm,I.D=27.86mm 

	10 
	J 
	O.D=33.4mm,I.D=27.86mm 

	11 
	K 
	O.D=33.4mm,I.D=27.86mm 

	12 
	L 
	O.D=33.4mm,I.D=27.86mm 


 
B. PROPERTIES OF ALUMINIUM:- 
	S.NO 
	MATERIAL PROPERTY 
	VALUE 

	1 
	Youngs modulus 
	69 GPa 

	2 
	Poisson’s ratio 
	0.33 

	3 
	Tensile strength 
	310MPa 

	4 
	Thermal conductivity 
	167W/m-K 

	5 
	Density 
	2700kg/m3 


 
C. PROPERTIES OF TITANIUM:- 
	S.NO 
	MATERIAL PROPERTY 
	VALUE 

	1 
	Density 
	4 540 kg/m³ 

	2 
	Yield Strength 
	880MPa 

	3 
	Tensile strength 
	950MPa 

	4 
	Modulus of elasticity 
	113.8GPa 

	5 
	Shear modulus 
	44GPa 

	6 
	Poisson ratio 
	0.342 


 
 
D. PROPERTIES OF CARBON FIBER:- 
 
	S.NO 
	MATERIAL PROPERTY 
	VALUE 

	1 
	Density 
	1800kg/m3 

	2 
	Tensile strength 
	3530MPa 

	3 
	Compressive strength 
	3000MPa 

	4 
	Modulus of elasticity 
	230GPa 

	5 
	Thermal conductivity 
	0.008W/mK 


 
E. TOTAL DEFORMATION:- 
 
	S.NO 
	LOAD 
	ALUMINIUM 
	TITANIUM 
	CARBON FIBER 

	1 
	2400N 
	0.97266mm 
	0.50390mm 
	0.63722mm 


 
F. EQUIVALENT STRESS:- 
 
	S.NO 
	LOAD 
	ALUMINIUM 
	TITANIUM 
	CARBON FIBER 

	1 
	2400N 
	66.431MPa 
	64.905MPa 
	153.86MPa 


 
G. WEIGHT OF CHASSIS(kg):- 
 
	 
	Aluminium 
	Titanium 
	Carbon Fiber 

	Weight 
	7.713kg 
	12.864kg 
	5.0121kg 


 
 
 
 
 
 
 
 
9.2 GRAPHS:- 
 
GRAPH-1:MATERIAL Vs DEFORMATION(mm) 
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GRAPH-2:MATERIAL Vs EQUIVALENT STRESS 
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CHAPTER-10 CONCLUSION & FUTURE SCOPE 
 
10.1 CONCLUSION:- 
 
Hence the design is done by using CATIA V5 software and structural analysis of the different materials has been done by using aluminium, titanium and carbon fibre must be done by using ANSYS software. 
From the result it is observed that the total deformation is less for carbon fibre compared to other materials named aluminium and titanium. So the design is safe. While comparing the all three material aluminium and carbon fibre cheapest in cost but as for our result the total deformation must be lesser in titanium and carbon fibre. 
By using carbon fibre it has less density compared to aluminium and titanium materials and also cheap in cost, so this is the best suitable material for chassis frame and is expected to perform better with satisfying amount of weight reduction. It also increases the fuel efficiency. Carbon fiber is an ideal material for creating a lightweight chassis that is strong and rigid. It is resistant to fatigue and can be moulded into complex shapes, making it a popular choice for high-performance vehicles. 
The present paper is totally based on computational results obtained from Ansys R23 and subjected to static loading conditions, for further implification of the two wheeler chassis in real life we need to conduct fatigue analysis using computational process and also conduct theoretical and experimental results in testing machines to verify the outcome. 
 
10.2 FUTURE SCOPE:- 
 
The use of carbon fiber in the design and analysis of two-wheeler chassis has already gained significant attention due to its potential to offer several benefits, including high strength-to-weight ratio, corrosion resistance, and improved durability. Here are some potential future scopes for the design and analysis of two-wheeler chassis using carbon fiber: 
1. Further weight reduction: Carbon fiber has an extremely high strength-to-weight ratio, which makes it an ideal material for reducing the weight of the chassis while maintaining its strength 
and stiffness. Future research could focus on further reducing the weight of the chassis by exploring new carbon fiber composites and manufacturing processes. 
2. Customization and optimization: The use of carbon fiber allows for greater customization and optimization of the chassis design. The material can be molded into complex shapes and configurations to optimize the chassis for specific performance requirements, such as handling and stability. 
3. Sustainability: Carbon fiber is a relatively eco-friendly material, as it can be recycled and reused. Future research could focus on developing more sustainable carbon fiber composites and manufacturing processes to reduce the environmental impact of two-wheeler production. 
4. Integration with other technologies: Carbon fiber chassis can be integrated with other technologies, such as advanced suspension systems and electric powertrains, to improve the overall performance and efficiency of two-wheelers. Future research could focus on optimizing the integration of these technologies to achieve the best results. 
Overall, the future scope for the design and analysis of two-wheeler chassis using carbon fiber is broad and promising. With continued research and development, we can expect to see even more innovative designs and improvements in the performance and sustainability of two-wheelers. 
The present paper is totally based on computational results obtained from Ansys R23 and subjected to static loading conditions, for further implification of the two wheeler chassis in real life we need to conduct fatigue analysis using computational process and also conduct theoretical and experimental results in testing machines to verify the outcome. 
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